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1 Informatii privind
siguranta

Ingrijirea produsului

Traducerea acestui document este doar pentru
referinta.

Daca apar inconsistente fntre versiunea ih Engleza
si versiunea tradusa, versiunea ih Engleza contine
informatiile corecte.

n Atentie

e Pentru a evita stricarea sau functionarea

defectuoasa:

* Nu expuneti produsul la caldura excesiva cauzata
de echipamente sau lumina solara directa.

* Nu scapati produsul pe jos si aveti grija sa nu
lasati produse sa cada peste acest player.

* Nu lasati produsul sa intre fn contact cu apa. Nu
expuneti mufa de la casti sau compartimentul
pentru baterii la apa.

* Telefoanele mobile active din vecinatate pot
cauza interferente.

* Salvati-va fisierele! Asigurati-va ca aveti fisierele
originale. Philips nu este responsabil pentru
pierderea informatiilor daca produsul se strica.

* Gestionati-va (transferati, stergeti, etc.) fisierele
doar cu software-ul furnizat pentru a evita aparitia
problemelor.

» Nu folositi agenti de curatare care contin alcool,
amoniu, benzen, sau substante abrazive, deocarece
acestea pot strica produsul.

Despre temperaturile de stocare si operare

* Folositi aparatul intr-o locatie unde tempe-
ratura este cuprinsa intre O si 35°C (32 si
95°F).

« Stocati aparatul intr-o locatie unde tempe-
ratura este cuprinsa intre -20 si 45°C (-4
si 113°F).

e Durata de viata a bateriei poate fi scurtata
in conditii de temperatura scazuta.

fnlocuirea accesoriilor sau componentelor:
Vizitati www.philips.com/support pentru a
comanda accesorii sau componente pentru
fnlocuire.

Siguranta auzului

Ascultati la volum moderat.

A asculta la casti la volum mare poate duce la
pierderea auzului. Acest sistem poate produce
sunete puternice care pot duce la pierderea
auzului pentru persoanele normale, chiar sila o
expunere de mai putin de un minut. Aceste
sunete sunt oferite pentru persoanele care au
deja probleme cu auzul.

Sunetul poate fi ihselator. Cu timpul, “nivelul de
confort” al auzului se poate adapta la sunete mai
puternice. Deci, dupa ascultare prelungita ceea ce
pare “normal”’ poate fi de fapt tare si daunator
pentru auzul dvs. Pentru a preveni acest lucru,
setati volumul la un nivel sigur fnainte ca auzul sa
se adapteze.

Pentru a stabili un nivel de volum sigur:
Setati volumul la un nivel mic.

Mariti usor volumul pana ce sunetul se aude clar
si confortabil, fara distorsiuni.

Ascultati pentru perioade rezonabile de timp.
Expunerea prelungita la sunet, chiar si la nivele

sigure, poate duce la pierderea auzului.
Asigurati-va ca folositi echipamentul pentru
perioade rezonabile de timp.

Asigurati-vd cd ati citit urmatoarele reguli
Tnainte de a folosi castile.

Ascultati la volum moderat si pentru perioade
rezonabile de timp.

Aveti grija sa nu reglati volumul in timp ce auzul
de adapteaza.

Nu folositi castile sau sistemul i situatii potential
periculoase.

Nu folositi castile ih timp ce conduceti, mergeti cu
bicicleta etc. Acest lucru este periculos si poate
duce la provocarea accidentelor ih trafic.



Modificari

Modificarile neautorizate de cétre fabricant pot
duce la pierderea dreptului de folosire a
utilizatorului.

Informatii privind drepturile de autor
Toate numele de marci si produse apartin de

companiile sau organizatiile respective.
Duplicarea neautorizata a fnregistrarilor care au

fost downloadate de pe Internet sau dupa
discurile audio reprezinta o incalcare a legilor
privind drepturile de autor si a tratatelor

internationale.
A face copii neautorizate a materialelor protejate,

fisierelor, transmisiilor sau fhregistrarilor audio,
reprezinta o fhcalcare a drepturilor de autor si
este un act criminal. Acest echipament nu trebuie
folosit pentru astfel de scopuri.

Windows Media si logo-ul Windows sunt marci
fhregistrate ce apartin de Corporatia Microsoft
din Statele Unite ale Americii si/sau din alte tari.

Fiti responsabili! Respectati drepturile de autor.

[ Be responsible ]

Respect copyrights

Philips respecta proprietatea intelectuala a aftor
persoane, si rugam utilizatorii sa faca acelasi lucru.
Este posibil ca continutul multimedia de pe
Internet sa fi fost creat si/sau distribuit fara

autorizatia proprietarului de drept.
Copierea sau distribuirea continutului neautorizat

poate fhcalca legile privind drepturile de autor din

diverse tari, inclusiv din tara dvs.
Respectarea drepturilor de autor ramane

responsabilitatea dvs.

nregistrarea si transferarea pe player-ul portabil a
fisierelor video downloadate de pe calculator este
intentionata pentru utilizare personalad. Puteti
folosi astfel continutul doar pentru utilizare
personalg, fara utilizare comerciala si trebuie sa
respectati drepturile de autor oferite cu
continutul. Asemenea instructiuni declara ca nu se
vor face copii continutului respectiv.

Date de logare
Philips este comis sa imbunatateasca calitatea

produsului si experienta utilizatorului. Pentru a
intelege utilizarea profilului a acestui dispozitiv,
dispozitivul va salva anumite informatii ih memoria
non volatila. Aceste informatii sunt folosite pentru
a identifica si detecta problemele care pot aparea
in timpul folosirii dispozitivului. Aceste informati,
de exemplu, vor fi durata de redare in modul
audio, durata de redare in modul Tuner, de cate
ori s-a terminat energia din baterie, etc. Aceste
informatii nu vor dezvalui continutul de pe
dispozitiv sau sursa de downloadare. Aceste
informatii pot fi accesate DOAR daca utilizatorul
returneaza dispozitivului la un centru Philips.
Informatiile salvate vor fi facute disponibile doar la
cerere.

Decodor Monkey’s Audio

@ Monkey's Audio SDK si codul sursa pot fi
folosite pentru a permite redarea formatu-
lui APE, decodarea sau suportul oricarui
produs, gratis sau comercial. Folosirea co-
dului pentru alte scopuri care nu suporta

formatul APE oficial, necesita acordul in
scris al autorului.

@ Sursa Monkey's Audio poate fi inclusa fn
GPL si in sursa de software deschisg, chiar
daca Monkey Audio ih sine nu este subiec-

tul unor cerinte externe pentru licentiare
sau a altor restrictil.

@ Schimbarile si fimbunatatirile facute acestui
cod trebuie contribuite fnapoi la proiectul
Monkey's Audio fara restrictionare sau ce-
rere de plata, exceptie in cazul n care aveti
acordul ih scris al autorului.

@ Orice cod surs3, idei sau librarii folosite tre-
buie clar recunoscute ih software-ul care
foloseste codul.

@ Desi software-ul a fost testat detaliat, auto-
rul nu este responsabil pentru stricaciunile
aparute fn cazul folosirii gresite.



Daca nu sunteti in totalitate de acord cu aceste

prevederi, nu mai folositi codul sursa si stergeti-| Reciclarea pl’OdUSUlUi

din dispozitiv.

Acest sistem este fabricat din materiale si
componente de fhalta calitate, care pot fi

reciclate si reutilizate.

Decodorul FLAC

Copyright (C)
2000,2001,2002,2003,2004,2005,2006,2007,2008,
2009 Josh Coalson

Cand acest simbol este atasat unui produs,
fnseamna ca produsul respectiv corespunde
cerintelor Directivei Europene 2002/96/EC. Va
rugam sa va informati despre sistemul de

Redistribuirea sau utilizarea in forma sursa sau
binara, cu sau fara modifican, sunt permise avand
in vedere ca urmatoarele conditii sa fie
ihdeplinite:

colectare separata a produselor electrice si
electronice.

e Redistribuirea codului sursa trebuie sa
contina nota de mai sus, aceasta lista cu
conditii si urmatorul act.

e Redistribuirile in forma binara trebuie sa
contina nota de mai sus, aceasta lista cu [
conditii si urmatorul act fh documentatie
si/sau in alte materiale oferite in timpul
distribuirii.

*  Numele fundatiei Xiph.org sau numele

Va rugam sa actionati in functie de legile locale si
sa nu va debarasati de produsele vechi cu
deseurile menajere normale. Debarasarea corecta
va duce la prevenirea consecintelor potential
negative asupra mediului inconjurator dar si
asupra sanatatii umane.

contribuitorilor nu pot fi folosite pentru
a comercializa sau promova produse care
deriva de la acest software fara acordul in

scris. )
'!‘ Avertisment

ACEST SOFTWARE ESTE OFERIT DE CATRE [ndepartarea bateriei va invalida garantia si va

TITULARII DE DREPT SI DE CATRE
COLABORATORI “ASA CUM E" $I ORICE
GARANTIE EXPRIMATA SAU IMPLICATA,
INCLUSIV DAR NU ESTE LIMITATA LA,
GARANTIILE COMERCIALE IMPLICATE

PENTRU UN ANUMIT SCOP SUNT NEGATE.

N NICI UN CAZ NU VOR FI GASITI
RESPONSABILI FUNDATIA S
CONTRIBUITORII PENTRU ORICE
STRICACIUNE DIRECTA, INDIRECTA,
INCIDENTA, SPECIALA, EXEMPLARA SAU

CONSECVENTIALA (INCLUSIV, DAR NU ESTE

LIMITATA LA, ACHIZITIONAREA SAU
SUBSTITUTIONAREA BUNURILOR SAU
SERVICIILOR; PIERDEREA DE INFORMATII
SAU PROFITURI, SAU BLOCAREA AFACERID.

distruge produsul.

* Urmatoarele instructiuni de indepartare si de-
barasare sunt pasi care trebuie facuti atunci
cand produsul nu mai este functional si garan-
tia a expirat.




Acest produs contine o baterie refncarcabila care
corespunde cerintelor Directivei Europene
2006/66/EC. Bateria nu trebuie debarasata cu
deseurile menajere normale.

Pentru a pastra functionalitatea si siguranta
produsului, duceti acest produs la un centru
de colectare sau un centru de reparare oficial
unde o persoana calificata va indeparta sau in-

locui bateria, cum este prezentat mai jos:

©®

Va rugam sa va informati despre legile locale
privind sistemul de colectare separat pentru
baterii. Debarsarea corecta a bateriilor va ajuta
la prevenirea consecintelor potential negative
asupra mediului fnconjurator dar si asupra
sanatatii umane.

Notd pentru Uniunea Europeand
Acest produs corespunde cu cerintele Uniunii
Europene privind interferentele radio.



2 Noul dvs. player
RAGA

Player-ul RAGA va permite sa:

* Redati fisiere MP3 si WMA neprotejate

* Ascultati la radio FM (optiune disponibila
doar pentru anumite modele!)

»  Faceti hregistrari

Ce gasiti in cutie

Verificati daca ati primit urmatoarele obiecte:

Player

Ghid de instalare rapida

,,,,,,,,,,,,,,,,,,,,

Quick start guide

PHILIPS

Nota

* Imaginile sunt doar pentru referinta. Philips fsi
rezerva dreptul de a schimba culoarea/designul
produsului fara notificare prealabila.




3  Pregatiri

Prezentarea comenziilor si
conexiunilor

® @ 6
&

/
/

J/
O @ ©

S

i Mufa pentru casti
MIC  Microfon
Afisaj
5 Apasati: trece la nivelul anterior

Tineti apasat: trece la meniul
principal.

© OLEE

¢/ +e* In ecranul de redare, apasati: ma-
reste/micsoreaza nivelul volumului.
n ecranul de redare, tineti apasat:

mareste/micsoreaza repede nivelul
volumului.

In lista, apasati: navigheaza in sus/jos

Mn lista, tineti apasat: navigheaza
repede ih sus/jos.
@ 4] Apasati: reda/pauzé/confirma

@ e.- / -t Apasati: navigheaza inainte/inapoi

Tineti apasat: navigheaza repede
fnainte/fhapoi.

fn ecranul de redare, tineti apasat
pentru a scana piesa curenta.

® Glisati si apasati: pornire/oprire
& Glisati: blocheaza/deblocheaza tastele

@ RESET Apasati: reseteaza player-ul.

s Glisati: mufa pentru conectorul
USB

Limitarea volumului

Atentie

o Ascultarea la volum mare chiar si pentru un
moment, poate fi ddunator pentru ascultator.

Puteti seta un nivel de volum pentru player-ul
RAGA pentru a limita iesirea maxima a volumului.
1  Din meniul principal, selectati [Settings] >
[Sound settings] > [Volume limit].
2 Apasati pe tastele de volum ‘e / -®
pentru a regla nivelul volumului.
3 Apasati pe Pl pentru confirmare.
= (Cand setati o limita pentru volum,
player-ul RAGA nu va mai putea
trece peste limita setata chiar daca
apasati pe butonul “*-.
Pentru a activa volumul maxim:
1 Selectati [Settings] > [Sound settings] >
[Volume limit].

2 Setati limita de volum la maxim.

3 Apasati pe pIl pentru confirmare.



Prezentarea meniului principal

Meniu Mod Pentru a
ir| Music Reda piese audio
digitale
0] FM radio  Asculta la radio
U Recording  Crea sau asculta
fnregistrari
ol Folder Vizualiza fisierele din
view foldere
o Settings Personaliza setarile din
player
® Now Afisa ecranul de redare
playing curent

Conectare si incdrcare

Player-ul RAGA are o baterie incorporata care
poate fi ihcarcata prin conectarea la portul USB
din calculator (cablul USB este inclus).

« Cand conectati player-ul RAGA la calculator, veti
fi rugati sa selectati una din urmatoarele:

* [Charge & transfer] sau [Charge & play].

e Player-ul RAGA va selecta automat [Charge &
transfer], daca nici o selectie nu este facuta.

Conectarea player-ului la calculator

1 Conectati mufa USB din cablul USB furnizat
la un port USB liber din calculator.

2 Conectati mufa cea mica din cablul USB la
mufa USB din player.

3 Porniti calculatorul.
& Player-ul RAGA se va incarca.

Instalarea Philips Songbird pentru
prima data

Cand conectati player-ul RAGA pentru prima
data la un calculator, o fereastra va fi afisata:

1 Selectati Install Philips Songbird.

2 Urmariti instructiunile de pe ecran pentru a
completa instalarea.

Nota

e Procesul de instalare necesita acordul cu termenii
si conditiile de licenta.

Daca fereastra nu este afisata automat:

1 Selectati My Computer (Windows XP /
Windows 2000) / Computer (Windows
Vista / Windows 7).

2 Click dreapta pe iconita Philips GoGear
RAGA.

Selectati Install Philips Songbird.

DA w

Urmariti instructiunile de pe ecran pentru
a completa instalarea.

Nota

o Procesul de instalare necesita acordul cu termenii
si conditiile de licenta.




Reinstalarea software-ului Philips
Songbird (dupa prima instalare)

Important!

Software-ul Philips Songbird este preinstalat pe
player-ul RAGA.

Pentru a elibera memoria player-ului RAGA,
fisierul este sters automat dupa prima instalare
a software-ului.

Daca doriti sa reinstalati software-ul, urmariti
instructiunile de mai jos:

—

Conectati player-ul la calculator.

2 Asigurati-va ca ati conectat calculatorul la
Internet, si deschideti Windows Explorer.

3 Windows Explorer, click dreapta pe RAGA,
si selectati optiunea de instalare a software-ului

Philips Songbird.
= Calculatorul va downloada fisierul
de pe Intemet.

4 Urmariti instructiunile de pe ecran pentru a
completa procesul de instalare.

Indicatorul de nivel al bateriei

Indicatorul afiseaza nivelul aproximativ de energie
din baterie:

=) | | L 1
100%  75% 50% 25% 0%

= (Cand indicatorul clipeste pe ecran,
fnseamna ca bateria nu mai are ener-
gie. Player-ul va salva setarile si se va
opri ih 60 de secunde.

* Bateriile refncarcabile au un numar limitat de
cicluri de thcarcare. Durata de viata si numarul de
cicluri de fncarcare ale bateriei variaza in functie
de utilizare si setari.

* Iconita de fhcarcare se va opri si iconita @va fi
afisatd cand incarcarea este completa.

Ea Sfat

* Pentru a economisi energie si a mari durata de
redare a player-ului, selectati % > [Display
Settings] > [Screen off timer] si asigurati-va ca
cea mai mica optiune este selectata.

Software-ul incarcat pe player

Player-ul RAGA vine cu urmatorul software:
. Philips Songbird (care va ajuta la
actualizarea software-ului firmware
al player-ului si la transferul fisiere-
lor media).

Fisierele incarcate pe player

Urmatoarele fisiere sunt fncarcate pe player-ul
RAGA:

. Manual de utilizare

*  Raspunsuri la intrebari frecvente



4 Actualizarea
software-ului

Player-ul RAGA este controlat de catre un
program intern numit firmware. Versiuni noi ale
acestui program vor aparea dupa ce ati
achizitionat acest player.

Programul software numit Philips Songbird va
ajuta calculatorul sa caute versiuni firmware noi.
Instalati Philips Songbird pe calculator (consultati
capitolul “Instalarea software-ului”) si urmariti
instructiunile pentru actualizare (consultati
capitolul “Verificarea si actualizarea manuala a
software-ului”).

Nota

o Fisierele audio nu sunt afectate de catre
actualizarea software-ului firmware.

Verificarea si actualizarea
manuala a software-ului

1 Asigurati-va ca ati conectat calculatorul la
Internet.

2 Conectati player-ul la calculator (consultati
sectiunea “Conectare si fhcarcare”).

3 Din calculator, apasati pe Start > Programs >
Philips > Philips Songbird pentru a lansa apli-
catia Philips Songbird.

Z Selectati Tools > Updates.
= Philips Songbird va verifica daca au

aparut versiuni firmware noi pe In-
ternet si le va instala.

5 Urmariti instructiunile de pe ecran pentru a
actualiza software-ul firmware de pe player-ul
RAGA.

6 Asteptati pana ce actualizarea este completa,
apoi deconectati player-ul de la calculator.
L» Player-ul RAGA se va reporni dupa
actualizare si va fi gata de folosire.

10



5 Pornirea si oprirea
player-ului

1 Pentrua porni sau opri player-ul, glisati si tineti
apasat pe O pentru aproximativ 2 secunde.

Oprirea automata

Player-ul RAGA are o optiune de oprire
automata care permite economisirea energiei.
Dupa |10 minute in modul Idle (muzica nu este

redatd, nici o tasta nu este apasata), player-ul
RAGA se opreste.

1 Glisati si tineti apasat pe O pentru aproxi-
mativ 2 secunde pentru a pomni player-ul.

Blocarea tastelor

Player-ul RAGA are un buton care va permite
sa blocati tastele pentru a preveni operarea
accidentala.

1 Pentru a bloca tastele in timpul redarii, mutati
butonul glisant pe pozitia &.
=  Toate tastele cu exceptia tastelor de
volum vor fi blocate si o iconita laca-
tel va fi afisata.

2 Pentru a debloca tastele, mutati butonul glisant
pe pozitia centrala.

11



6 Philips Songbird

Player-ul RAGA vine cu software-ul Philips

Songbird.

Software-ul Philips Songbird va ajuta sa:

o Cumparati fisiere media (audio si video)
online.

*  Creati librani media.

¢ Gestionati librariile media.

» Redati fisierele audio si video.

*  Sincronizati fisierele media cu player-ul
RAGA.

Cand Philips Songbird este lansat pentru prima

datd, alegeti una din urmatoarele optiuni pentru

a importa fisierele media catre libraria media

Songbird:

* Importarea unei librarii iTunes existente

*  Scanarea fisierelor media din anumite di-
rectoare (Puteti selecta urmarirea unui
anumit folder, astfel incat daca fisiere sunt
adaugate sau sterse in acel folder, fisierele
vor fi adaugate sau sterse automat din li-
braria media Songbird).

Crearea unei librarii media

Selectati una din urmatoarele optiuni pentru a
crea o librarie media cu Songbird:

Copierea fisierelor de pe un CD (Rip)

Drept optiune originala, software-ul Philips
Songbird va instala urmatoarele add-ons care
sunt necesare pentru a copia fisierele de pe
un CD:

« CD Rip Support

*  Gracenote Metadata Lookup Provider

Setarea optiunilor de copiere de pe disc

1 Din calculator, lansati programul Songbird.

12

2 Selectati Tools > Options ...
3 Selectati casuta CD Rip, si alegeti optiunile de
copiere.

4 Apasati pe OK pentru confirmare.

Importarea fisierelor media dintr-un
director

Urmatorii pasi va prezinta cum sa importati
fisierele media (audio si video) care sunt salvate
in alta locatie din calculator sau din retea.

1 Din calculator, lansati programul Songbird.
2 Dinbara Songbird, apasati pe File, apoi se-
lectati Import Media...
3 Selectati fisierele media (audio si video), si
apasati pe OK.
= Fisierele media sunt adaugate la libraria
media.

Sfat

* Daca ati selectat un folder cu fisiere audio si
video, software-ul va scana folder-ul si va adauga
fisierele catre libraria media (titlurile care se
repeta vor fi ignorate).

Importarea fisierelor media iTunes

1 Din calculator, lansati programul Songbird.
Selectati Tools > Options...

Din bara Songbird, selectati casuta Media
Importer, apoi selectati iTunes Import/Export.

Verificati locatia si optiunile din libraria media.

Uh WNHN

Selectati Import Library.
= Software-ul va importa libraria iTunes
catre libraria Songbird.



Exportarea fisierelor media catre
libraria iTunes

1 D calculator, lansati programul Songbird.

2 Selectati Tools > Options...

3 Dinbara Songbird, selectati casuta Media
Importer, apoi selectati iTunes Import/
Export.

U1 A

Selectati Export Library.
= Software-ul va exporta libraria
Songbird catre libraria iTunes.

Verificati locatia si optiunile din libraria media.

Obtinerea continutului de la sursele online

Puteti cumpara fisiere media de la magazinele
online, precum:

« 7/-digital

Verificati specificatiile pentru player-ul RAGA

pentru a afla ce servicii sunt disponibile pentru
dvs.

Importarea inregistrarilor de pe
player-ul RAGA

1 Din calculator, lansati programul Songbird.

2 Dinbara Songbird, apasati pe File, apoi
selectati Import Media...
3 Selectati ihregistrarile de pe player-ul
RAGA, apoi apasati pe OK.
= Thregistrarile selectate sunt listate
fn libraria media.

Sfat

o Daca ati selectat un folder care contine
fnregistrari, software-ul va scana folder-ul si va
adauga automat toate fnregistrarile catre libraria
media (titlurile care se repeta vor fi ignorate).

Navigarea prin libraria media

Libraria media Songbird este structurata fn modul
urmator:

@ Player Pane (panoul in care este afisat
player-ul RAGA)

@ Library Pane (panoul unde este afisat
continutul librariei)

@ Service Pane (panoul unde sunt afisate
informatiile aditionale, precum listele de
redare)

@ Information Pane (panoul unde veti gasi
informatii despre optiunile selectate)

Organizarea si gestionarea
librariei Songbird

Gestionarea librédriei media de cdtre
programul Songbird

1 Din calculator, lansati programul Songbird.
Selectati Tools > Options...

Din bara Songbird, selectati casuta Manage
Files.

Bifati Allow Songbird to manage my files.

Uh WN

Setati optiunile in functie de cum doriti sa
va organizati fisierele media.
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Stergerea fisierelor media din libraria
Songbird

1 milibraria Songbird, click dreapta pe un fisier,
apoi selectati Remove.
2 I fereastra afisatd, apasati pe Remove pentru
a confirma stergerea fisierului.
= Fisierul selectat este sters din librarie si
din toate listele de redare (drept optiune
originalg, fisierul este doar “indepartat’.
Fisierul media se afla in locatia originala
din calculator sau din retea).

Sfaturi

 Pentru a selecta mai multe fisiere din calculator,
tineti apasat pe CTRL.

o Pentru a selecta mai multe fisiere consecutive din
calculator, tineti apasat pe Shift.

Stergerea fisierelor

Mai jos este prezentat modul in care puteti sterge
fisierele in Windows Explorer.

1 player-ul RAGA conectat la calculator,
deschideti Windows Explorer.

2 Localizati fisierele media din player-ul RAGA.

3 Stergeti fisierul media in acelasi mod cum

ati sterge fisierele din orice alta locatie din
calculator.
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Urmarirea unui folder de citre
programul Songbird

Puteti lasa programul Songbird sa:

*  Monitorizeze continutul unui folder, si

*  Adauge sau sa stearga fisierele media
din librarie pentru a se potrivi cu con-
tinutul folder-ului selectat.

Din calculator, lansati programul Songbird.
Selectati Tools > Options...

Din bara Songbird, selectati casuta Media
Importer, apoi selectati Watch Folders.

A WN-

Selectati folder-ul pe care doriti ca programul

Songbird sa-I monitorizeze.

9 Folder-ul selectat este monitorizat si
continutul librariei Songbird va fi mo-

dificat in functie de continutul folder-
ulu.

Album Artwork

Alegeti una din optiunile de mai jos pentru a
afisa imagini pentru albumele de pe player.
Din calculator, lansati programul Songbird.
« Din bara Songbird, selectati Tools > Get

Album Artwork.
Ly Daca nici un titlu nu este selectat, progra-

mul Songbird va atribui imagini pentru
toate titlurile din librarie.
* Click dreapta pe titlurile selectate.
= Programul Songbird va atribui imagini
pentru titlurile selectate.

Listele de redare

Drept optiune originald, software-ul Philips
Songbird va instala urmatoarele add-ons care

sunt necesare pentru a copia fisierele de un
CD:
« (D Rip Support

*  Gracenote Metadata Lookup Provider



Crearea unei liste

1 Din calculator, lansati programul Songbird.

2 Alegeti una din urmatoarele optiuni pentru

a crea o lista noua:

. Din bara Songbird, selectati File >

New Playlist.

*  Click dreapta pe bara din partea
stanga, si alegeti New Playlist.
Apasati pe simbolul + din partea
de jos a panoului Service.
= O noua lista va fi afisata in panoul

Service.

3 Introduceti un nume pentru lista noua.

Addugarea titlurilor la lista

1 Din calculator, lansati programul Songbird.
2 Selectati unul sau mai multe titluri.

3 Alegeti una din urmatoarele optiuni pen-
tru a adauga titlurile la lista de redare:

. Folositi optiunea “drag and drop”
pentru a copia titlurile catre lista
din panoul Service.

. Click dreapta pe selectie, si selec-
tati Add to Playlist > The_name_
of_your_playlist.

9 Toate titlurile selectate sunt adaugate

la lista.

Stergerea titlurilor din listd

1 Din calculator, lansati programul Songbird.
2 Selectati o lista.
3 Click dreapta pe titlul pe care doriti sa-|
stergeti, apoi apasati pe Remove.
B Titlul selectat este sters din lista.

Schimbarea aspectului librariei
Songbird

Puteti schimba schema de culori si de design a
librariei Songbird. Acest lucru se numeste
“changing feathers”. Noile optiuni sunt instalate
si gestionate precum add-ons.

A cauta noi optiuni (feathers)
1 Din calculator, lansati programul Songbird.
2 Dinbara Songbird, selectati View >
Feathers > Get more feathers. ..
= Software-ul va cauta mai multe
optiuni (feathers).
L Urmariti instructiunile online pen-
tru a instala optiunile noi.

Formatarea player-ului
(stergerea informatiilor)

Philips Songbird are optiunea Format care va
permite sa formatati player-ul si sa stergeti toate
fisierele din memoria acestuia.

Atentie

o Urmatoarea procedura va sterge toate fisierele
de pe player-ul RAGA.

1 Instalati Philips Songbird pe calculator (con-
sultati capitoulul “Instalarea software-ului”),
apoi lansati programul.

fn panoul player-ului Philips Songbird, apasati
pe RAGA.

n panoul librariei, apasati pe casuta numita
Tools.

n panoul Tools, apasati pe Format device.

Uh W BN

Urmariti instructiunile de pe ecran pentru a
completa procedura de reparare.
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Repararea player-ului (resetarea
optiunilor la starea originald)

Philips Songbird are o optiune de reparare care
va permite sa resetati player-ul RAGA la starea
originald. Tnainte de a ihcepe, salvati-va fisierele

care sunt stocate pe player.

Atentie

* Urmatoarea procedura va sterge toate fisierele
de pe player-ul RAGA, si va reseta optiunile la
starea originala.

1 Instalati Philips Songbird pe calculator (con-
sultati capitoulul “Instalarea software-ului”),
apoi lansati programul.

2 T bara de meniu Philips Songbird (in partea
de sus), apasati pe meniul Tools si selectati
Repair my RAGA.

3 Urmariti instructiunile de pe ecran pentru a
completa procedura de reparare.
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7/ Muzica

A asculta muzica

1  Din meniul principal, selectati §3 pentru a
intra fh modul Muzica.

2 Navigati prin sub-meniuri pentru a selecta
piesele.

3 Apasati pe Pl pentru a porni sau fhtrerupe
redarea.
*  Apasati pe B pentru a trece la
nivelul anterior.
«  lineti apasat pe & pentru a tre-
ce la meniul principal.

Navigarea in interiorul unei piese

1 m timp ce ascultati o piesa, apasati pe “:®/ e
pentru a naviga repede fnainte/ihapoi ih inte-
riorul piesei.

Cautarea fisierelor audio

Din meniul principal, selectati § pentru a intra in
modul Muzica.

Player-ul RAGA va ofera urmatoarele meniuri cu
optiuni:

[All songs]
Piesele sunt listate ih ordine alfabetica.

[Artists]

Artistii sunt listati in ordine alfabetica.
Albumele sunt listate fh ordine alfabetica.
Piesele sunt listate in ordinea din album.

[Albums]

Albumele sunt listate ih ordine alfabetica.
Piesele sunt listate th ordinea din album.

[Playlists]
[Playlist-on-the-go]
Piesele sunt listate ih ordinea din lista.

[Audiobooks]*
Cartile audio sunt listate in ordine alfanumerica.

Note

» *Puteti achizitiona carti audio de pe magazinele
online, precum audible.com.

* Player-ul RAGA reda cartile audio precum piesele
normale.

Stergerea uneia sau mai multor piese

Folositi software-ul Philips Songbird pentru a
sincroniza fisierele media. Alternativ, puteti sterge
fisierele in Windows Explorer.

1 Conectati player-ul la calculator.

2 h Windows Explorer, localizati folder-ul
audio din RAGA.

3 Stergeti fisierele audio fn acelasi mod i care
stergeti fisierele de pe calculator.

Nota

* Alternativ, puteti selecta ™ din meniul principal si
puteti afisa fisierele din foldere.

17



8 Radio (optiune
disponibila doar
pentru anumite
versiunil!)

A asculta la radio

1  Din meniul principal, selectati & pentru a
intra fn modul radio.

= Cablul de la casti are si rolul de
antena FM.

Sfat

» Redarea de la radio se va opri cand selectati alt
mod de redare sau cand player-ul este oprit.

Cautarea manuald a unui post
de radio.

fn modul ®, puteti cauta manual un post de
radio.

1 Pentru a cauta urmitorul semnal puternic,
tineti apasat pe “**/ ‘o'

2 Pentrua imbunatati frecventa, apasati scurt
pe -2/ -e".

Cautarea automata a posturilor
de radio

Optiunea Auto-tune din player-ul RAGA va ajuta
sa cautati si sa salvati automat posturile de radio.

1 M modumcu castile conectate, selectati
[Auto tune].
* Daca sunteti rugati, selectati [Yes]
pentru confirmare.
' Radioul va cauta automat posturile
de radio si le va salva sub presetari.
Exista 20 de presetari disponibile.
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*  Pentru a opri cautarea automata,
apasati pe 5,

« Pentru a trece la meniul principal,
tineti apasat pe & pentru 2 secunde.

Redarea unui post de radio
presetat

1t modul @, selectati o presetare.
2 Apasati pe e sau pe .- pentru a selecta
alta presetare.

3 Pentru a cauta un alt post cu semnal puter-
nic, tineti apasat pe -‘e sau pe e.- pentru 2
secunde.

 Pentru a trece la meniul principal, tineti
apasat pe 5 pentru 2 secunde.

Nota

» Pentru a reda presetarile, mai intai trebuie sa
salvati posturile de radio sub presetari.




9 Inregistrari

Inregistrarea de la radio FM
(optiune disponibila doar
pentru anumite versiuni!)

1  Din meniu principal, selectati @ pentru a
intra fh modul radio.
2 Navigati prin meniu pentru a selecta [Start
FM radio recording].
*  Apasati pe Pl pentru a porni sau
intrerupe fnregistrarea.

Apasati pe 5 pentru oprire.

AW

Apasati pe Pl pentru a salva inregistrarea

sau apasati pe ®© pentru anulare.

' fhregistrarile sunt salvate pe player
(Numele fisierului: FMRECXXXWAY,
unde XXX reprezinta numarul fhregis-
trarii care este generat automat).

Sfat

 Veti gasi inregistrarile in [Recordings Library] >
[FM Radio].

Inregistrarea vocii/audio

Mai jos este prezentat modul in care puteti
fhregistra audio/vocea cu ajutorul microfonului
incorporat (consultati sectiunea “Prezentare”
pentru a afla locatia microfonului).

1 Din meniul principal, selectati & > [Start

voice recording].

*  Apasati pe -+ pentru a porni sau
fntrerupe fnregistrarea.

Apasati pe H pentru oprire.

w N

Apasati pe

sau apasati pe 5 pentru anulare.

& [hregistrarile sunt salvate pe player
(Numele fisierului: VOICEXXXWAY,
unde XXX reprezinta numarul inregis-
trarii care este generat automat).

pentru a salva fnregistrarea

Sfat

 Veti gasi inregistrarile in [Recordings Library] >

[Voice].

A asculta inregistrarile

Pentru a asculta thregistrarile FM radio™:

1 Din meniul principal, selectati & > [Recordings
library] > [FM radio].

2 Selectati o thregistrare.

3 Apasati pe PIl pentru a reda fhregistrarea.

Note

* *nregistrarea FM radio este disponibila doar
pentru anumite versiuni. Consultati meniul
player-ului RAGA pentru a afla ce optiuni sunt
disponibile.

Pentru a asculta la fnregistrarile audio/a vocii

1 Din meniul principal, selectati & > [Recordings
library] > [Voice].

2 Selectati o inregistrare.

3 Apasati pe plI pentru a reda inregistrarea.
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Incarcarea inregistrarilor Folosirea player-ului pentru
pe un calculator transferul de fisiere

Folositi software-ul Philips Songbird pentru

a sincroniza fisierele media.

Alternativ, puteti transfera fnregistrarile ih

Windows Explorer.

1 Conectati player-ul la calculator: 1 Con'ectajti player-ul la cglfulfltor (consultati
sectiunea “Conectare si hcarcare”).

Mai jos este prezentat modul in care puteti folosi
player-ul RAGA pentru a stoca si transfera
fisierele.

2 n Windows Explorer, deschideti RAGA. , . , o
2 Din calculator in Windows Explorer, copiati

3 Selectati folder-ul Recordings > Voice sau fisierele catre player-ul RAGA.

FM radio*.
Z Copiati thregistrarile catre locatia dorita din

calculator. Sfat

. * Folositi calculatorul pentru a transfera fisierele
Nota fnapoi pe calculator sau pentru a sterge fisierele
de pe player.

* *lhregistrarea FM radio este disponibila doar
pentru anumite versiuni. Consultati meniul
player-ului RAGA pentru a afla ce optiuni sunt
disponibile.

Stergerea inregistrarilor

Mai jos este prezentat modul in care puteti
sterge fnregistrarile in Windows Explorer.
1 Conectati player-ul RAGA la calculator.

2 T Windows Explorer, localizati folder-ul
Recordings > Voice sau FM radio*.

3 Stergeti fnregistrarile i acelasi mod fh care
stergeti fisierele de pe calculator.

Nota

* *nregistrarea FM radio este disponibila doar
pentru anumite versiuni. Consultati meniul
player-ului RAGA pentru a afla ce optiuni sunt
disponibile.
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10 Setari

Mai jos este prezentat modul fn care puteti

personaliza setarile din player-ul RAGA:

Din meniul principal, selectati % pentru a intra

fn modul de setare.
Navigati prin meniurile de setare fn modul

urmator:

1 Apasati pe “® / “e* pentru a selecta o optiune.

2 Apasati pe Pl pentru a confirma selectia si
pentru a trece la nivelul urmator (cand este

disponibil).

e Apasati pe 5 pentru a trece la nivelul anterior.

*  Tineti apasat pe 5 pentru a iesi din

meniul %
fn meniul % , urmatoarele optiuni sunt
disponibile:
Setéri Meniul cu optiuni Meniul cu sub-optiuni
Play mode Repeat * Repeat off
* Repeat 1
Repeat all (default)
Shuffle Shuffle off (default)
Shuffle all
Sound settings  FullSound Off
On* (default)
Equalizer Off (default) s Jazz
Rock » Classical
Funk * Techno
Hip hop * Custom
Volume limit Off (default)
Set

Sleep timer

* Time left: [x] minutes
» Off (default)
* Set

Display settings

Theme

Black (default)
Blue
Red

Screen off timer

15 sec. (default)
30 sec.

45 sec.

Always on
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Setdri Meniul cu optiuni Meniul cu sub-optiuni
Language * Czech * Norwegian Traditional Chinese
 Danish * Polish Japanese
* Greek * Portuguese Korean
* English * Portuguese (Brazilian) Thai (some versions
* (default)German * Russian only)
* Spanish * Slovak Hebrew (some versions
* French * Finnish only)
* Italian * Swedish Arabic (some versions
* Hungarian  Turkish only)
* Dutch * Simplified Chinese
Information Capacity
Free space

Firmware version
Model
Support site

Factory settings

Restore factory settings?

(Files are not affected.)

Yes
No

*Optiunea Equalizer se dezactiveaza cand modul
FullSound este selectat.
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11 Informatii
tehnice

Alimentare

Alimentare: baterie interna refhcarcabila de 220
mAh Li-ion polymer

Timpul de redare | (muzica): 22 de ore

Software
Philips Songbird: pentru a actualiza software-ul

firmware si pentru transferul de muzica.

=

. 'Bateriile refncarcabile au un numar limitat de
cicluri de ihcarcare. Durata de viata a bateriei si a
numarului de cicluri de incarcare variaza i functie
de utilizare si setari.

« 21GB = | miliard de biti, capacitatea de stocare
este mai mica. Capacitatea intreaga de stocare nu
va fi disponibila deoarece o parte din memorie
este rezervata pentru player. Capacitatea de
stocare se bazeaza pe piese MP3 de 4 minute si
cu codare la 128kbps.

« 3Viteza de transfer variaza in functie de sistemul
de operare si de configuratia software-ului.

Conectivitate
Casti 3.5 mm
USB 2.0 de mare viteza

Sunet

Separarea canalelor: 45 dB

Frecventa de raspuns: 20 - 18,000 Hz
lesirea alimentarii: 2 x 2.4 mW
Raportul semnal-zgomot: > 84 dB

Redarea audio

Formatele suportate

MP3:

MP3 bit rate: 8 - 320 kps si VBR

MP3 sample rate: 8, 11.025, 16, 22.050, 32,
44.1, 48 kHz

WMA:

WMA bit rate: 10 - 320 kbps CBR, 32 — 192
kbps VBR

WMA sample rate: 8, | 1.025, 16, 22.050, 32,
44,1, 48 kHz

FLAC:
FLAC sample rate: | - 1,048 kHz

APE:
APE sample rate: 8 - 48 kHzZWAV

Capacitatea memoriei
Capacitatea memoriei interne

SA2RGAO2K 2GB NAND Flash
SA2RGA04K 4GB NAND Flash
SA2RGAOBK 8GB NAND Flash

2,

Transferul de muzici3

Songbird (sincronizare)
Windows Explorer (drag and drop)

Afisaj
Ecran LCD color cu 128 x 64 pixeli

Cerintele sistemului

«  Windows® XP (SP2 sau mai mare) / Vista / 7
« Procesor Pentium Il 800 MHz sau mai mare

« 512 MB RAM

« Spatiu liber de 500MB pe hard disk

» Conexiune la Internet

¢ Windows® Internet Explorer 6.0 sau mai nou
* CD-ROM drive

¢ Port USB
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12 Glosar

B

Bit rate
Bit rate este numarul de biti care sunt procesati

pe unitate de timp. Bit rate este masurat de
obicei ih mai multi biti pe secunda (kilobiti pe
secunda: kbps). Termenul de bit rate este sinonim
cu raportul de transfer al informatiilor (sau mai
simplu zis raportul informatiilor).

C

Compresie
fn termeni audio, acesta este un proces temporar

sau permanent de reducere a informatiilor audio
pentru transmisie sau stocare mai eficienta a
pieselor audio. O reducere temporara in marimea
fisierului se numeste compresie “non-lossy”, si nici
o informatie nu este pierduta. O reducere
permanenta ih marimea fisierului (precum fh cazul
fisierelor MP3) se numeste compresie “lossy”, si
implica pierderea informatiilor inutile.

D

Decibeli (dB)
O unitate de masura folosita pentru a exprima

diferenta relativa in energia sau intensitatea audio.

F

FM (Frequency Modulation)

fn transmisia radio: o metoda de modulatie ih
care frecventa pentru transmiterea voltajului
variaza in functie de frecventa voltajului de
modulatie.
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Frecventa de raspuns
In raza de frecvente produse de catre o boxa, de

la cea mai mica frecventa pana la cea mai mare. n
timp ce frecventa optima este de 20-20,000 Hz
(Herti), raza auzului uman pentru indivizi este
mult mai restransa. Un sistem de boxe cu o raza
completa va reproduce cat mai mult posibil din
aceasta raza pentru a acoperi toate variatiile.
Driverele individuale sunt limitate la reproducerea
anumitor parti din spectrum, part pentru care au
fost programate, astfel hcat raspunsul lor este
limitat dar necesar atunci cand se ia ih
considerare fabricarea unui sistem audio complet.

Full Sound
FullSound™ este o tehnologie inovativa fabricata

de catre Philips. FullSound™ reproduce fidel
detaliile sonice ale sunetului compresat, astfel
imbunatatind experienta audio, fara aparitia
distorsiunilor.

L

LCD (Liquid Crystal Display)
Probabil cel mai comun mod de a afisa

informatiile vizuale ale echipamentelor
electronice.

(Comepresia) Lossless

Un sistem pentru reducerea numarului de biti
(densitatea) intr-un semnal audio fara a corupe
semnalul original.

M

MP3

Un format de fisier cu un sistem de compresie a
informatiilor. MP3 este abrevierea de la Motion
Picture Experts Group | (or MPEG-1) Audio
Layer 3. Cu formatul MP3, un CD-R sau CD-RW
poate contine de |0 ori mai multa informatie

decat un disc normal.



MSC [Mass Storage Class]
Clasa de dispozitiv USB de stocare (sau USB

MSC sau UMS) este un set de protocoale de
calculare care ofera o interfata pentru
dispozitivele de stocare. Dispozitivele care
suporta acest standard se numesc dispozitive
MSC (Mass Storage Class).

MTP [Media Transfer Protocol]

Media Transfer Protocol suporta transferul
fisierelor audio si video catre un dispozitiv audio
sau video portabil.

R

Rip (ripping)
Folosind un program software care “ia” fisierele

audio digitale de pe un disc si le transfera catre

drive-ul unui calculator. Integritatea informatiilor
este pastrata, deoarece semnalul nu trece prin
cardul audio al calculatorului si nu necesita
transformarea ih format analog. Transferul digital-
catre-digital creaza un fisier WAV care poate fi
transformat in fisier MP3.

S

SuperScroll
SuperScroll™ este o optiune de navigare care are

taste cu dubla actiune. SuperScroll™ va permite
sa navigati repede prin librariille mari. Cu cat tineti
mai mult apasat pe buton cu atat viteza de
cautare se va mari.
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